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Photoshop Shortcuts Competencies  
All shortcuts specific to Adobe Photoshop 
 
Competencies Section to label tools and screen areas 
 
Label: 
Options bar 
Tool bar 
Palettes 
Palette well  
Tools 
 Elliptical 
 Polygonal 
 Marquee 
 Magnetic Lasso 
 Magic wand 
 Move 
 Crop 
 Slice 
 Slice Selection 
 Healing Brush 
 Spot Healing Brush 
 Brush 
 Pencil 
 Clone Stamp 
 Eraser 

Gradient 
 Blur 

Sharpen 
Smudge 
Burn 
Dodge 
Sponge 
Type 
Pen 
Rectangle Shape 
Ellipse Shape 
Eye dropper 
Zoom 

Foreground/Background Color 
Swap Foreground/Background 
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Default Colors 
Quick Mask Mode 
Change Screen Mode 
Layer Styles 
Add Mask 
New Adjustment Layer 
Link Layers 
Lock Transparent Pixels 
Lock Image Pixels 
Lock Movement 
Lock All 
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Photoshop Competencies 
 
1. Explain Bitmap Images: 

(Images based on a map or screen of pixels. Each pixel has it’s own color identity.) 
2. Explain Resolution: Where can you go to check an image’s resolution? 

(Amount of pixels within an image. Mainly measured in ppi or dpi. High resolution is approx 
300 dpi, medium 150, and low 72. Image > Image Size.) 

 3. Explain Vector Images: 
(Mathematical based graphics that draw resolution independent curves between points at 
velocities described by anchors and handles, sometimes called Bezier curves.) 

4. What type of graphic is Photoshop best at manipulating? 
 (Bitmap) 
5. How will having a selection affect a filter application? 
 (Filter gets applied directly to selection only) 
6. How many pixels wide will a Single Row Marquee tool select? 
 (tricky, as wide as your document is) 
7. Explain how the magic wand tool works: How will a noncontiguous option change the selection? 

(Selects areas of similar color, depending on 256 tolerance levels. A noncontiguous option will 
selects all areas of similar color across the document and not just within range of the pixel 
selected) 

8. How do you change from freehand and straight-edge lasso segments mid-selection? 
 (Hold Option to switch during a selection for greatest control) 
9. What do the frequency and edge control controls do for the magnetic lasso tool? 

(Frequency puts down more fasteners more often, edge contrast defines a lasso’s sensitivity to 
edges) 

10. How do you add and subtract selection areas to an existing selection? 
 (Hold shift to add, hold option to subtract) 
11. How can you easily selecting everything within a single layer using only the Layers Palette? 
 (Command-Click the layer’s thumbnail image) 
12. Describe 5 translation functions of the transform tool: 
 (Move, rotate, scale, skew, distort, perspective, flip horizontal or vertical) 
13. Describe anti-aliasing: 
 (subtle gradients of color to “soften” jaggy pixel edges, especially along curves) 
14. Explain Color Gamut and how color models vary. Be specific and include at least three models: 

(Gamut is a limit of color that can be reproduced by a specific device. Eyes have the largest 
gamut, light sources of color use combo of RGB and have a medium gamut, pigment sources 
use combo CMY +Black and have smallest gamut) 

15. Describe how a color derived from a light color model may appear when printed? 
(Original RGB color will appear muddy and less vibrant once printed due to CMY gamut 
limits) 

16. What types of devices use light color models? How about pigment color models? 
 (TV, Monitors, Cell phones. Printers, paints, ink.) 
17. Tell me everything you know about the HSB color model. Describe at least 3 points: 

(Hue, Sat., Brightness. Hue – Color name like blue or orange – measured in 360 degrees. 
Saturation – Strength or purity versus gray – measured in percentage with 0 being gray. 
Brightness – lightness or darkness of hue – measured in percentage with 0 being black) 

18. Describe two different ways to select and use a color: 
(color picker tool, click color, apply with brush. Click on foreground/background color, color 
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picker palette, type numerical values, apply with gradient.) 
19. What are two common gamut warnings found within the Color Picker dialog box? 

(3D box icon – color is outside of web-safe gamut. Triangle icon – color is outside of CMYK 
gamut) 

20. Where do you click to modify the color, transition, style and opacity of a gradient? 
 (gradient thumbnail in gradient options bar) 
21. Describe how to scan a document here in the Hedlund lab: 

(put item on scanner platen upside-down, Image capture> File > Import > Scanner Name, 
choose options for resolution, color mode, and effects, preview, scan, save file in Photoshop.) 

22. How will adjusting canvas size differ from adjusting image size? 
(Canvas size keeps the image at the same resolution, just adds/subtracts pixels around image 
boundaries) 

23. How do you set specific crop dimensions within the crop tool? 
(use the options bar to put in width, height, and resolution or choose a crop tool preset from the 
options bar drop down) 

24. Explain the difference between levels and curves? 
(levels will adjust contrast and brightness where curves will adjust overall hue, saturation, and 
brightness based on either RGB or CMYK color models.) 

25. Explain the relationship between CMY and RGB in the curves image adjustment? 
(If adjusting cyan you will be either adding or subtracting red. If adjusting magenta you will be 
either adding or subtracting green. If adjusting yellow you will be either adding or subtracting 
blue.) 

26. How does the clone-stamp tool work and what key do you use in conjunction with it? 
(It works by choosing a nearby sampling area of the image – hold option and click – and 
brushing over scratches, dust or other imperfections with a dynamic sample area replacement.) 

27. Explain how a layer style is beneficial over a filter? 
(layer styles are not permanent, can be removed, and further edited from the original. Filters are 
permanent and are limited in adjustments after applied) 

28. Describe what an erased section will look like on a background layer? 
(Rather than showing transparent, a background layer will show erased sections as whatever the 
background color is set to. This will not necessarily be white.) 

29. How do you create your own custom brush tip? 
 (Make a selection, choose Edit >Define Brush Preset) 
30. What will happen to a work path if you continue to draw additional paths? 
 (Work path is temporary, will be deleted once a new path is drawn.) 
31. What will happen to vector information saved in a Photoshop PDF if opened in Illustrator? 
 (Vectors will be preserved and editable) 
32. How are layer masks beneficial over cutting and pasting desired pixels from a background? 

(layer masks are fast and easy to use, they preserve original data in case the desired pixels need 
to be adjusted, masks can be moved independently of the image for animations) 

33. How do quick masks work and how are they beneficial over regular selection methods? 
(Quick masks are an organic and intuitive way to “paint-out” an area you wish to select or 
deselect. Levels of transparency can be achieved with the quick mask selection that cannot with 
regular selection methods.) 

34. Describe four parts of the design process: 
(Start with an idea – this may include thumbnails, mind-mapping and looking through 
inspirational designs. Make a mock-up – a simple rendering of 1-3 ideas. Gather Content –
searching for the right photos and elements and collecting them into a natives folder. Assemble 
Content – the final process of layout and design) 
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35. Describe snapping: 
(snap allows precise layout by pulling elements as you move them near to guides, grids, 
document edges, and other layer elements) 

36. How do you use guides? 
(Guides are pulled directly from the rulers. They help in layout and grid principles.) 

37. Where can you see a list of filters and thumbnails of what each filter does? 
 (Filter Gallery) 
38. Describe the benefits of digital printing over mechanical “offset” printing? 

(Digital printing can be printed directly from a file, quick turn-around, short-run projects, and 
targeted marketing campaigns) 

39. Describe the benefits of mechanical “offset” printing over digital printing? 
(Quality, spot colors, detailed varnishes and coatings, lower cost on higher quantities) 

40. Describe the “offset” printing process: 
(files colors are made into film separations (sometimes skipped), separations burned to metal 
plates (halftone dots) that pick up colors and laid onto paper in four or more processes – usually 
towers on a press that put color down in sequence.) 

41. Why is PDF such a popular printing file? 
(Cross platform, embedded natives like fonts and hi-res images, pre-flattened artwork, high 
compatibility) 

42. What are three areas of to consider when “going to Print” and describe each? 
(Color – Color management workflows to get a fair match between screen and paper. 
Resolution – get information from printer on DPI or LPI necessary for job. Format – File format 
to provide printer – will most likely ask for PDF, TIFF, or working files.) 

43. Why is it important to follow a color management workflow? 
(Ensures that the best possible match between colors on difference devices. This makes sure 
that what you see on screen will closely match what goes on paper or is visible on other 
screens) 

44. Explain LPI and it’s relationship to DPI:  
(Lines per Inch is a screen of halftone dots and different frequencies, angles and dot sizes. 
Higher LPI creates smaller and tighter dots good for glossy magazines and slick brochures. 
Lower LPI creates larger and rougher dots good for course papers and newspapers. LPI is 
generally 1.5 to 2 times smaller in relationship to DPI.) 

45. What file formats are best for bitmaps and what are best for vectors? 
(TIFF, PSD, JPEG, GIF, PNG are best for bitmaps. EPS, AI, PDF, SVG, SWF are best for 
vector) 

46. What is a good image compression for the Tagged Image File Format? 
 (LZW or none) 
47. What important printer marks can be added to a document through the Print with Preview 
command? 
 (Edge and Center Crop marks, Registrations marks, etc) 
48. Why is image optimization important for the web? 
 (the smaller the images, the faster the page will download) 
49. What are three areas to consider in web optimization and describe each? 

(Format – File type and compression best for the style of graphic. Color – type of color 
reduction algorithm to use. Size – overall image file-size and document-dimensions.) 

50. Describe the lossy image compression technique and name a few file formats that use it: 
(lossy will literally discard image data in favor of file size. It may find a patch of like color and 
discard some of the differences in that patch. JPEG and GIF both use lossy.) 

51. Describe the lossless image compression technique and name a few file formats that use it: 
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(Lossless will keep data in favor of more efficient compression techniques. Image quality does 
not suffer, but file size is not reduced as much. PNG and SVG use lossless compression.) 

52. What are four bitmap, web-graphic file-formats and describe pros and cons of each: 
(GIF – pros: works best with solid areas of color, small file-size, widely supported, animated, 
transparency, cons: 256 colors, lossy compression, not good for photographs. JPEG – pros: best 
for photographs, millions of colors, well supported, small file size, can be interlaced, cons: 
lossy compression, no transparency, no animation. PNG-8 – Pros: same as GIF, but smallest 
lossless file compression, cons: same as GIF, but not as widely supported, not animated. PNG-
24 – Pros: millions of colors, perfect for photographs, preserve sharp details, lossless 
compression, multi-level transparency. Cons: large file sizes, not as widely supported on web, 
no animation.) 

53. Name and describe three color reduction algorithms within the Dynamic category: 
(Preceptual – Gives priority to colors the human eye has greater sensitivity to. Selective – Gives 
priority to broad areas of color from the web-safe gamut. Adaptive – Gives priority to dominant 
colors in the image.) 

54. What is a good way to know how long a page will take to download at certain speeds? 
(Use the Save for Web, or Save Optimized As dialog boxes that explain the files-size to 
download-speed relationship.) 

55. Content-Aware Fill: 
 (Understand image manipulation and techniques in how to remove pixels) 
56. Puppet Warp: 

(How to precisely warp or stretch graphics, text, or image elements to create unique new looks 
for your designs in Photoshop) 

57. Camera Raw:  
(Explain and demonstrate how to remove image noise while preserving color and detail 

58. New media management tools 
 (Demonstrate the use of Adobe Mini Bridge panel) 
 (Demonstrate effective batch process to maximize workflow) 
59. Brush tools enhancements 
 (Demonstrate how to use and why to use the mixer brush) 
60. Repoussé technology. 

(Understand the capabilities and use of Repoussé technology: twist, rotate, extrude bevel, 
inflate and use of Phostohop basic texture to apply to 3D object) 
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